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Trademarks and Copyrights

Copyrights
Copyright © 2009-12 Kollmorgen™
Information in this document is subject to change without notice. The software
package described in this document is furnished under a license agreement or non-
disclosure agreement. The software may be used or copied only in accordance with
the terms of those agreements.

This document is the intellectual property of Kollmorgen™ and contains proprietary
and confidential information. The reproduction, modification, translation or disclosure
to third parties of this document (in whole or in part) is strictly prohibited without the
prior written permission of Kollmorgen™.

Trademarks
KAS and AKD are registered trademarks of Kollmorgen™.
SERVOSTAR is a registered trademark of Kollmorgen™.
Kollmorgen™ is part of the Danaher Motion company.
Windows® is a registered trademark of Microsoft Corporation
EnDat is a registered trademark of Dr. Johannes Heidenhain GmbH.
EtherCAT® is registered trademark of Ethercat Technology Group.
PLCopen is an independent association providing efficiency in industrial automation.
INtime® is a registered trademark of TenAsys® Corporation.
Codemeter is a registered trademark of WIBU-Systems AG.

Kollmorgen Automation Suite is based on the work of:

l Apache log4net library for output logging (distributed under the Apache License).
l bsdtar and libarchive2, a utility and library to create and read several different archive

formats (distributed under the terms of the BSD License – see terms – see "Licenses"
for terms).

l bzip2.dll, a data compression library (distributed under the terms of the BSD
License).

l Curl software library
l DockPanel Suite, a docking library for .Net Windows Forms (distributed under the MIT

License).
l FileHelpers library to import/export data from fixed length or delimited files.
l GNU gzip1 (www.gnu.org) is used by the PDMM (distributed under the terms of the

GNU General Public License http://www.gnu.org/licenses/gpl-2.0.html).
l GNU Tar2 (www.gnu.org) is used by the PDMM (distributed under the terms of the

GNU General Public License http://www.gnu.org/licenses/gpl-2.0.html).
l jQuery File Tree, a file browser plugin (distributed under the MIT License).
l JsonCpp software (distributed under the MIT License – see http://jsoncpp.so-

urceforge.net/LICENSE for terms)
l Mongoose software (distributed under the MIT License)

1Copyright (C) 2007 Free Software Foundation, Inc. Copyright (C) 1993 Jean-loup Gailly. This is free soft-
ware. You may redistribute copies of it under the terms of the GNU General Public License <http://www.gnu.o-
rg/licenses/gpl.html>. There is NOWARRANTY, to the extent permitted by law. Written by Jean-loup Gailly.
2Copyright (C) 2007 Free Software Foundation, Inc. License GPLv2+: GNU GPL version 2 or later
<http://gnu.org/licenses/gpl.html> This is free software: you are free to change and redistribute it. There is NO
WARRANTY, to the extent permitted by law. Written by John Gilmore and Jay Fenlason.
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l MVVM Light Toolkit components for Model – View –ViewModel patterns with Win-
dows Presentation Foundation (distributed under the MIT License).

l Qwt project (distributed under the terms of the GNU Lesser General Public License)
l U-Boot, a universal boot loader is used by the AKD-PDMM (distributed under the

terms of the GNU General Public License, http://www.gnu.org/licenses/gpl-2.0.html).
The U-Boot source files, copyright notice, and readme are available on the dis-
tribution disk that is included with the AKD-PDMM.

l ZedGraph class library, user control, and web control for .NET (distributed under the
LGPL License).

l Zlib software library
l Zlib1.dll, a data compression library (distributed under the terms of the BSD License).
All other product and brand names listed in this document may be trademarks or
registered trademarks of their respective owners.

Disclaimer
The information in this document (Version 2.6 published on 12/18/2012) is believed
to be accurate and reliable at the time of its release. Notwithstanding the foregoing,
Kollmorgen assumes no responsibility for any damage or loss resulting from the use
of this help, and expressly disclaims any liability or damages for loss of data, loss of
use, and property damage of any kind, direct, incidental or consequential, in regard
to or arising out of the performance or form of the materials presented herein or in
any software programs that accompany this document.

All timing diagrams, whether produced by Kollmorgen or included by courtesy of the
PLCopen organization, are provided with accuracy on a best-effort basis with no
warranty, explicit or implied, by Kollmorgen. The user releases Kollmorgen from any
liability arising out of the use of these timing diagrams.
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1 Introduction
Welcome to KAS v2.6! This release contains new features and many improvements.
This document is intended to help existing users understand the differences between
this and the prior release. If you are new to KAS, you will be better suited starting off
with other documents, such as the Installation Guide.

This document has five sections: 

l "Installation" (see page 9) — this section covers system requirements as well as pro-
vides firmware, software, and hardware information.

l "What's New" (see page 11) — an overview of new features.
l "What's Changed" (see page 19) — this section discusses how this release may

affect some of your older projects. It let's you know what to do when upgrading, espe-
cially if there is anything you need to be careful about.

l "What's Fixed" (see page 23) — a list of issues addressed in this release.
l "Known Issues" (see page 25) — this section contains issues we are aware of, and

methods for avoiding or working around them.

This document contains links to more complete descriptions in the online help.

Wherever you find this icon , you may click it and go to the help topic.
Please note that these links will not work if this PDF is opened from a location
other than the KAS install directory.

Kollmorgen™ | May 2012 7
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2 Installation

2.1 System Requirements
Element Requirement

KAS IDE KAS IDE and Simulator are compatible with any PC running the following operating systems:

l Windows® XP (32- or 64-bit)
l Windows Vista® (32- or 64-bit)
l Windows® 7 (32- or 64-bit)

Please be sure your operating system is fully updated with the latest
patches.

The PC must meet the minimum requirements specified by the operating system manufacturer
for CPU speed and RAM.

WebServer Amodern web browser is required to access the web server. We recommend Internet Explorer 9, Mozilla
FireFox (v.11 or later), or Google Chrome.

2.2 Firmware & Software Requirements
KAS is comprised of several software components integrated together to provide a
complete motion system. We recommend the following component software versions
for best performance and compatibility.

2.2.1 IDE, Controller, and Programmable Drive Software
Software Images Recommended Version Download

KAS IDE 2.6.0 n/a

AKD PDMM Runtime Firmware 2.6.0

PAC master image (includes KVB 1.20.542) 2012-04-30 n/a

2.2.2 AKD Drive Firmware Requirement
KAS is compatible with AKD-M (AKD PDMM Drive) and AKD-P (Motion Tasking Drive
or Position Indexer) drives. The recommended firmware version is dependent upon
your drive's model and revision. The operational image associated with this release is
01-08-00-003.

AKD firmware to use with version 2.6 Download
AKD PDMM Servo Drive Firmware AKD-M-MCEC-V01-08-00-003.i00

AKD EtherCAT drive, up to r.8 AKD-P-NAEC-V01-08-00-003.i00

AKD EtherCAT drive, r.9 AKD-P-NBEC-V01-08-00-003.i00

Resident image R_00-00-40-000 n/a

Please be aware that you may get a F106 error after upgrading your AKD
firmware. This indicates that non-volatile parameters are not compatible
between the two firmware versions. Resetting the drive to the default memory
values using Parameter Load will fix this error.

2.2.2.1 Mandatory Resident Firmware
The recommended resident firmware is v40. To reliably support the EtherCAT
Firmware Download, the resident firmware must be at least version 35. Please
contact Kollmorgen for any AKD Drive with resident firmware lower than v35.
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2.2.3 Kollmorgen Visualization Builder
Software Images Recommended Version Download
Kollmorgen Visualization Builder (KVB) master image 1.20.545

2.3 KAS Compatible Controls
KAS Runtime is compatible and has been verified with the following AKC hardware
models:

Description Model Number Main Characteristics
Panel PAC AKC-PNC-C1-224-10N-00-000 Mono-core 1.2 GHz CPU, 2GB RAM, 10"

display

Panel PAC AKC-PNC-C1-224-15N-00-000 Mono-core 1.2 GHz CPU, 2GB RAM, 15"
display

Panel PAC AKC-PNC-D1-224-15N-00-000 Dual-core 1.86 GHz CPU, 2GBRAM, 15" display

Panel PAC AKC-PNC-D1-224-17N-00-000 Dual-core 1.86 GHz CPU, 2GBRAM, 17" display

Performance Box Controller AKC-PLC-C1-224-00N-00-000 Mono-core 1.2 GHz CPU, 2GBRAM

Performance Box Controller AKC-PLC-D2-224-00N-00-000 Dual-core 1.86 GHz CPU, 2GBRAM

Performance Box Controller AKC-RMC-D2-224-00N-00-000 Dual-core 1.86 GHz CPU, 2GBRAM

AKD PDMM various

KAS IDE and Simulator should not be installed on a PAC or AKD PDMM.
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3 What's New

3.1 EtherCAT Devices Backup & Restore
The PAC and AKD PDMM support backup/restore of AKD drives on the
EtherCAT network. This feature is useful as a maintenance procedure to replace any
AKD drives in an operational machine.

Accessed from the controller's web server, this functionality allows you to backup and
restore the firmware and parameters of all AKD drives as well as all
EtherCAT devices' Unique IDs. This document provides an overview of the
functionality. See the Help for complete coverage of this subject.

AKD PDMM system backup or restore is a two-step process:

1. Backup or Restore the AKD PDMM.
2. Backup or Restore the AKDs (including the AKD drive inside the AKD

PDMM).

3.1.1 AKD Firmware
The AKD Backup and Restore feature requires an AKD firmware package containing
the AKD firmware for all hardware variants. All the drives must have the same
version for the backup to be performed. When a backup is performed, the system
checks the firmware. If the correct firmware package is not present on the SD Card
for AKD PDMM or on the flash for PAC, you will be prompted to specify a firmware
package.

The AKD firmware package is available in the KAS install (in the folder
Astrolabe\DrivesFW) or on our website (click here), in the "Firmware for KAS"
section.
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3.1.2 Restore
Clicking on Restore EtherCAT Devices will automatically scan the network, identify
replaced drives, and restore them. Clicking the Advanced button allows you to scan
the network and view the topology, including any differences. From here you may
manually select and restore devices.

Restore with a compatible drive
If the results of the network scan show that the replaced drive is compatible, the new
drive is selected in the topological map, and you can restore the device with backed-
up parameters.

Restore with an incompatible drive or network with different topology
If the results of the network scan show that the replaced drive is not compatible or
that the network topology does not match, the differences are shown so you can
correct the physical topology.
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3.1.3 Import/Export
This functionality is used to copy an AKD drive's backup to/from a local machine. If a
backup file exists you may export the backup file, otherwise only Import is available.

3.2 Motion Programming

3.2.1 PLCopen Registration
KAS supports two forms of registration within PLCopen, Mark to Mark and Mark to
Machine.

Mark to Mark Registration is implemented with the function block MC_MarkRegist
and is based on the desired distance between two registration marks. This distance
is used to qualify a “good” mark and then calculate a registration correction.

Mark to Machine Registration is implemented with the function block MC_
MachRegist and is based on a desired target position on a machine axis. Like Mark
to Mark registration, Mark to Machine registration uses the desired distance between
two registration marks to qualify a “good” mark but it uses an axis position as its
basis for correction.

For more detailed information please see Registration Application Guide in the
help.

3.2.2 Superimposed Axes with PLCopen
This feature allows the application program to superimpose the moves of multiple
axes ("Superimposed Axes") on top of the move of another axis ("Receiving Axis").
This is performed internally by adding the command deltas of the Superimposed Axes
to the command delta of the Receiving Axis. Up to four different Superimposed Axes
can be superimposed upon a Receiving Axis.

l MC_AddSuperAxis. This function block provides the ability to have an axis simul-
taneously geared and cammed to a master axis. This allows for adding a phase shift
to the slave axis over a determined distance on the master axis while the master axis
is moving.

l MC_RemSuperAxis. This function block removes an individual and/or all super-
imposed axes from an axis. This allows for disabling some or all of the superimposed
axes added to the command position or velocity directly from an application.

l MC_ReadParam. This function block has been updated to allow reading the inter-
polated command position and velocity for each axis. This allows you to properly
debug and monitor an application that contains Superimposed Axes.

3.2.3 Cam On The Fly
CAM on the fly is the ability to create and compile a Cam Profile from an application
using the new MLProfileBuild function block.

l MLProfileBuild. This FB provides the ability to create, modify, and compile CAM Pro-
files in an application.

l MLProfileRelease. This FB is used to release a profile before creating a new one.

Kollmorgen™ | May 2012 13
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3.3 PDMM-Specific New Features

3.3.1 Ethernet/IP
The KAS Runtime includes a fully
integrated Ethernet/IP Adapter driver and
Scanner driver for exchanging data with
Ethernet/IP tag-based devices such as
PLCs. Ethernet/IP Adapter, Scanner, Tag
Client, and FlexIO/Point IO configurations
are supported. The mapping of PLC
variables to Profinet is as simple as a
drag and drop. See Motion Bus and
Fieldbuses in the help for more
information.

3.3.2 Profinet
An AKD PDMM can be configured either
as a Profinet controller or as a Profinet
slave. From there, the mapping of PLC
variables to Profinet is as simple as a
drag and drop. KAS IDE also supports
network scans to automatically find and
configure each Profinet device that is on
a given network, and GSDML to import to
configure all type of devices. All the
standard Profinet configuration options
are available: watchdog, alarms, send
rate, Ethernet 802.3ac packets, virtual
LAN, etc.. See Motion Bus and
Fieldbuses in the help for more information.

3.4 New Features in the IDE
l Application Templates: The application templates now include PipeNetwork and

PLCopen motion engine templates that are written purely in FFLD or ST.
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l ST Intellisense. Intellisense is now available for Library projects.
l Start application from Online Configuration Mode. If you are in Online Configuration

mode and click the Start button, Online Configuration mode is automatically stopped
and the application is started.

l AKD analog output. AKD analog output is available on the AKD onboard IO map-
ping. The analog output is therefore available in the PDO.

l Controller's IP. The controller's IP address is displayed in the project tree.

l Functions/Function Blocks Reor-
ganized. Motion functions and func-
tion blocks that are used by both
Pipe Network and PLCopen have
been reorganized in the library tree.
These common motion functions
and FBs have been moved to
Motion/Common. There is also a
Motion/Common tree in the Koll-
morgen UDFBs.

l UDFB animated values while appli-
cation is running. Double clicking
on a UDFB in the project tree will
directly animate the value if there is
only one instance of this UDFB. You
will be prompted to select which
instance to animate if there are multiple instances.

If the UDFB was open before starting the application, it
will not be animated until it is double clicked in the
project tree.

l Keystrokes.
l The DEL key can now be used to delete any deleteable node in the project

tree.
l Alt + Shift + O is the new shortcut to open a project from the controller.

See "New Project Management Features" (see page 16) for more information
on this function.

l Alt + Shift + C is the new shortcut to Compare Projects. See "New
Project Management Features" (see page 16) for more information on this
function.

3.5 New Controller Features
l Reset to factory settings. Resetting to factory settings allows you to restore a PAC

or PDMM to the factory-defined state. This action will remove all of the following
data: 
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l any application
l project sources
l logs & log configuration
l user data (all the files created via the file FB)
l runtime configuration (auto-start and Profibus)
l retained variables
l controller and AKD backup
l crash dump

l EtherCAT receive frame error. The controller raises an A30 alarm when it’s not
able to send an EtherCAT frame. An A38 alarm is raised when a frame will not be
received or is received too late by the controller.

l User data storage. User data on the PAC and Simulator is stored in the Windows
user folder instead of Program Files. On Windows 7 this folder is C:\Users\<-
userlogin>\AppData\Local\Kollmorgen\KAS. The main benefits of this are:

l Application data (source of the project, compiled application, runtime con-
figuration, auto-start, fieldbuses, logs, files created with the file FB) are pre-
served after re-installation.

l Simulator can be run under Windows 7 with normal privileges. Admin priv-
ileges are not necessary.

3.6 New Project Management Features
l Save KAS project on controller. This saves a copy

of the complete KAS project file to the controller.
This option is found in the Controller Properties.

If PLC Online Change is activated, the previous
KAS file is kept in the controller. The correct KAS
project file is restored if an online change revert
is performed.

l Open project from controller. A project can be
opened directly from the controller. This functionality
is accessed from the File menu, or the shortcut Alt-
Shift-O.

l Open project from controller & view animated values. The animated values will be
displayed in the IDE after the project is opened from the controller.

l Upload the KAS source code. Projects that have been stored on the controller can
be uploaded to the local machine via the web server.

l Project comparison. Projects can be compared with other local projects or with
projects running on the controller.

l With a local project: The File menu item Compare Projects (Alt-Shift-C)
allows you to compare the open project with any project on your hard drive.
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The comparison is currently limited to the PLC source code.

l With the project on the controller: Clicking the Compare PLC programs but-
ton on the status bar compares the local project's code to the source code on
the controller. For this to work you must be connected to the controller and
have downloaded the project's source code.

l Password protection. Projects can be pass-
word-protected. A company name may also
be assigned to identify the owner. This func-
tionality is available in the File menu. .

l The status bar has an icon to indicate
if the project is password protected.

l Project files downloaded to the con-
troller retain the password protection,
if it was applied.

This feature requires additional compilation time. This is
because the source is re-encrypted at the end of each
compilation in order to download the protected project to
the controller.
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4 What's Changed
This section discusses changes in products that you should be aware of.

4.1 Project Download Manager 19

4.2 AKD Workbench GUI Integration 19

4.3 IDE 21

4.4 Kollmorgen Visualization Builder (KVB) 21

4.5 Backward Compatibility 21

4.1 Project Download Manager
Faster Project Download Manager. The IDE's Project Download Manager is now 50%
faster and more reliable. The new interface displays a unique progress bar.

4.2 AKD Workbench GUI Integration
The Kollmorgen WorkBench is a software tool for configuring, operating, and
diagnosing AKD drives. The WorkBench views have been re-integrated into the KAS
IDE. The new integration enables future IDE and WorkBench releases to be
synchronized, so the IDE will contain the latest WorkBench features.

New Views are available:

l Settings
l Wake & Shake
l Feedback 2
l Gain Scheduling
l Position Capture
There are a few differences in the user interface and operation, which are outlined
below.

4.2.1 Connection
To access the AKD views, the IDE
must be connected to the controller

and Online Configuration Mode
should be enabled or an application
should be running on the controller.
The Online Configuration Mode can be enabled or disabled from a new toggle button
on the menu bar.

4.2.2 Navigation

The individual AKD GUI views are accessible from the new navigation tree. This
replaces the horizontal tabbed navigation interface in the previous IDE versions.
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4.2.3 AKD GUI Tool Bar
The AKD GUI tool bar has been updated to provide additional buttons to navigate the
tree and save the AKD parameters to NV memory. The Clear Faults button changed
to Disable & Clear Faults and the Panic button has been removed.

4.2.4 Watch Window
Adding AKD variables to the watch window is only available when in Online
Configuration Mode or when an application is running. When adding a variable to the
watch window, the PLC Variable Selector window provides access to the AKD
variables for all the AKD drives on the EtherCAT network. The variable name is
based on the AKD parameter and also includes a simple text description.

4.2.5 User Options
The AKD GUI scope view settings can be preserved and reloaded automatically. This
option can be enabled/disabled from the Tools > User Options menu.
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4.3 IDE
l IDE & Web Server log configuration. Local and Controller log configuration may be

set individually. Local and runtime log configuration are separate. See Log Mes-
sages for more information.

Only the IDE can setup the log configuration for Local
logs. Controller logs can be configured from IDE or the
WebServer.

4.4 Kollmorgen Visualization Builder (KVB)

4.4.1 Version 1.20.545
With this version, KVB is compatible with Windows 7.

Version 1.20.545 is compatible with VS2010 redistributables.

4.4.2 Troubleshooting
If a project seems to be corrupted, clean the iX project. To do so:

l Open your KAS Project
l Open the KAS project's "temp" folder
l Open the "HMI/iX" folder
l Delete the following:

l "BuildFiles" folder
l "Temp" folder
l all .CRI files

4.5 Backward Compatibility
l Function calls in STmust now be terminated by “;”. Versions of KAS prior to v2.6 did

not enforce this condition. Existing projects that have ST code which is not terminated
by a semicolon will result in compiler errors which you will need to fix.

l AKD Analog Output is now part of the default PDO object. Any application that used
the Analog Output SDO (0x3470/3) needs to be updated to use the PDO instead of
the SDO object. SDO objects that are sent will be overwritten by the PDO.

l AKD Digital IO mode was previously found on the PLC IO mapping dialog. With the
new AKD GUI Integration it is now done directly inside the AKD Digital IO screens. If a
mode was set via the old KAS IO Mapping dialog, you should redo it manually, via
the AKD Digital I/O View.
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You will be presented with a warning if the IO mapping is not modified.

A remapped version of the AKD_1 shown above would look similar to the
following image.
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5 What's Fixed
Following are the issues corrected by this release.

Item # Issue
D-03746 Logs were not written to a file onWindows 7 under a standard User account.

D-03639 An application could not be started if a drive was enabled.

D-03583 AKD firmware parameters were lost when drives were upgraded.

D-03389 IO couplers were in error after writing a Unique ID and cycling the power.

D-03730 A cyclic error occurred when using DC with a SICKSafe device.

DT2674 Drive interface unit changes in PLCopen affected gearing and cammingmoves.

DT2676 Cam output had a position spike.

DT2627 Adjust RefPos in the case of autonomous move by the drive.

DT2633 SomeHMI panels were no longer visible after loading project from controller.
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6 Known Issues
Following is a list of known issues and methods to work around them.

6.1 Allow Simulator to Use HTTP Communication 25

6.2 Known Limitations 25

6.1 Allow Simulator to Use HTTP Communication
The Simulator needs to open TCP/IP ports to allow communication. The first time
Simulator is run, Windows will prompt you to block or unblock the KAS application.
You should allow access to all of these requests to ensure correct behavior.

Figure 6-1: Security Alert on Windows 7 and Windows XP.

The Simulator uses port 80 for the web server. This communication channel is
mandatory for Simulator to work properly. So please close any application, such as
VOIP, that may use port 80 before starting Simulator.

For more information see Start KAS Simulator in the online help.

6.2 Known Limitations

6.2.1 IDE
l Undo: The Undo action is not supported for AKD GUI views, control panel, or the

EtherCAT view.
l Find/Search/Replace function limitations:

l Search & Replace function is not supported in Pipe Network.
l Search & Replace for HMI are supported only with using CTRL+F

l Breakpoints: In SFC programs, breakpoints can only be set on transitions (i.e. in
First Level diagram), and not in steps or conditions. If a breakpoint is set on a tran-
sition, you can debug cycle by cycle.
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l PLC Variable mapping: each PLC variable can be mapped to an EtherCAT IO and
exclusively to:

l Modbus for an HMI
l Or to an PDMM onboard IO
l Or to an external driver like Profibus

For example we cannot map the same PLC variable to Modbus and Onboard
PDMM IO, but this is possible with a regular EtherCAT IO.

l AKD WorkBench GUI: You can experience an IDE disconnection the first time the
AKD GUI is opened. The reason is linked to the Just In Time .Net compiler that is
invoked the first time we call the AKD WorkBench GUI, which is CPU intensive and
can last more than 15 seconds. This potentially causes a connection timeout. If this
happens you will need to reconnect. A simple workaround is to double click on an
AKD node in the project tree, one-time per IDE session, before connecting.

Double-click on an AKD node before opening the
AKD WorkBench GUI.

l Intellisense: Intellisense is not active in Sequential Function Chart (SFC) programs.

6.2.2 KVB
l Variables: The ModBus variables are imported to KVB when KVB is opened. They

are not updated cyclically after opening. If other variables are exported in the IDE,
KVB should be closed and reopened.

l Import/Export: There isn't a built-in feature to import/export KVB projects.
l String export: String export over Modbus TCP is not supported.
l Alarm stops updating a tag value: It’s not advised to modify in the AlarmServer

action on the same tag as the one used to trigger it. A different variable should be
used.

l Running KVB with Simulator: There is a known issue when using Simulator on
some PCs running Windows 7 Home Premium Edition. This issue documented here.
To workaround this issue, delete the Platform system variable:

6.2.3 EtherCAT
l Cabling: Plugging the EtherCAT cable to the OUT port is not detected and not

reported as an error.
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l External EtherCAT Configuration: If you want to use an external EtherCAT XML file,
the file adaptedAKD.xml should be used as the ESI file for AKD. This ensures proper
operation with KAS.

6.2.4 PAC
l A38 Alarm: On the PAC High Range, at 4Khz, user may experience a A38 alarm

when having roughly 20 or more drives. This issue means the ECAT frame does not
return back to the controller within the same EtherCAT cycle.
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Global Support Contacts
North America
KOLLMORGEN
203A West Rock Road
Radford, VA 24141 USA

Web: www.kollmorgen.com
Mail: support@kollmorgen.com
Tel.:  +1 - 540 - 633 - 3545
Fax:  +1 - 540 - 639 - 4162

Europe
KOLLMORGEN Europe GmbH
Pempelfurtstraße 1
40880 Ratingen, Germany

Web: www.kollmorgen.com
Mail: technik@kollmorgen.com
Tel.:  +49 - 2102 - 9394 - 0
Fax:  +49 - 2102 - 9394 - 3155

Asia
KOLLMORGEN
Rm 2205, Scitech Tower, China
22 Jianguomen Wai Street

Web: www.kollmorgen.com
Mail: sales.asia@kollmorgen.com
Tel.:  +86 - 400 666 1802
Fax:  +86 - 10 6515 0263
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